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General Notes

Customer Relations

IVI Publishing wants you to be informed and delighted with our products. If you want to 
be informed about future releases of this product or any other IVI product, please return the 
registration card.  If you have comments about the current version of the Taking Control of Your 
Health, or suggestions for future versions, please send them to:

IVI Publishing, Inc.
Customer Relations

7500 Flying Cloud Drive
Minneapolis, MN  55344-3739

Fax: 612-996-6001
Phone (612) 996-6350

Customer Technical Support

This Readme file contains information about the most common problems users have 
experienced.  As you might suspect there are no guarantees that any two computers are 
configured the same.  Not even two from the same manufacturer.  If you are experiencing 
problems we are committed to addressing your concerns in a timely and professional manner.  

If you have questions about AT&T WorldNet (sm) Services, please call:

1-800-400-1447.

AT&T WorldNet Customer Service is available 24 hours a day, seven days a week.

If you are having problems installing or operating Taking Control of Your Health, and are 
unable to resolve your particular situation from reading this file, contact Customer Technical 
Support at:

612-996-6300.



Technicians are available for support calls Monday through Friday from 8 AM to 4 PM 
United States Central Time.  Calls after hours, and on weekends, are handled by our automated 
Technical Support answering system.  It contains an up-to-date, menu-driven, troubleshooting 
guide that provides more in-depth answers to difficulties you may be experiencing.

System Requirements

To access sound, animations, graphics and text you need:

A Multimedia PC 486/SX66MHz or Better.
Windows 95 or Windows 3.1 with MS-DOS 5.0 or later.
8 MB RAM.
Color monitor and video card supporting 256 colors at 640x480.
Double Speed CD-ROM drive.
Sound card and stereo speakers.
5 MB free disk space.
Mouse or compatible pointing device.

 Modem ( required for on-line feature only).

Installation for Windows 3.1 or 3.11

1. Installation for Windows 3.1 or Windows for Workgroups 3.11.  Start Windows in enhanced 
mode (type Win or Win/3).  The program will not run in standard mode.

2. Insert the Taking Control of Your Health disc in your CD-ROM drive.  Pull down the File menu 
from the Windows Program Manager.  Select Run.

3. In the Run dialog box click on the Browse button.  In the Browse dialog box, open the Drives 
list by clicking on the list drop down arrow.  Select the letter of your CD-ROM drive, usually D, E, 
or F.

(Your CD-ROM drive can be identified by the illustration next to the drive letter.  The CD-ROM 
drive illustration has a small red light and it shows a disk part way out of the drive.)

4. In the File Name list select Setup.exe (click on it so it is highlighted) and click OK.  The Browse
dialog box will close and the Run dialog box will become active.  Check to make sure Setup.exe 
is displayed on the Command Line (example - D:\Setup.exe) then click OK.  An install program 
will launch, guiding you through the installation process. 

5. The Taking Control of Your Health set-up program creates an IVI program group and a Taking 
Control of Your Health icon along with an Uninstall icon, a Readme icon and a Electronic 
Registration icon for running  these programs.

6. To run Taking Control of Your Health make sure the Taking Control of Your Health CD is in your
CD-ROM drive.  Double click on the Taking Control of Your Health icon to start the program.

7. Click on Taking Control of Your Health Readme icon to review important installation information
(the document you are reading now).  The Readme file also contains the Customer Technical 
Support number and a troubleshooting guide.  (You can also view the Readme file from the last 
screen of the setup program).

8. When you have completed reviewing the Readme file, click on exit to return to the Windows 
Program Manager.



Installation for Windows 95

1. Installation for Windows 95.  Insert the Taking Control of Your Health CD in your CD-ROM 
drive, after Windows 95 is fully up and running. Click on the "Start" button and go to and click on 
"Settings", now click on "Control Panel".  Once the "Control Panel opens, double click on 
Add/Remove Programs".  Now just follow the directions on the screen.  The installation wizard for
the Taking Control of Your Health will be run automatically, and will guide you through the 
installation process.  Just follow the direction on your screen.

2. The Taking Control of Your Health set-up program creates an IVI program group and a Taking 
Control of Your Health icon along with an Uninstall icon, a Readme icon and a Electronic 
Registration icon for running  these programs.

3. To run Taking Control of Your Health make sure the Taking Control of Your Health CD is in your
CD-ROM drive.  Double click on the Taking Control of Your Health icon to start the program

4. Click on Taking Control of Your Health Readme icon to review important installation information
(the document you are reading now).  The Readme file also contains the Customer Technical 
Support number and a troubleshooting guide. (You can also view the Readme file from the last 
screen of the setup program).

5. When you have completed reviewing the Readme file, click on exit to return to Windows.

Internet Browsers

An Internet browser is an application that gives you access to the Internet.  Taking 
Control of Your Health can link with a browser to give you access to AT&T HealthSite, an Internet 
web site created by Mayo Clinic and IVI Publishing.  This web site contains information to 
supplement the contents of Taking Control of Your Health, as well as technical support 
information and information about IVI Publishing and our other products.  To access our web 
pages, you need to install and configure an Internet browser, subscribe to an Internet provider 
and configure the Taking Control of Your Health for your browser.  

Note: If you do not desire Internet access, you do not have to do any of the above mentioned 
steps.

The Taking Control of Your Health CD-ROM comes bundled with the AT&T WorldNet Service 
software including Netscape Navigator (tm) browser.  If you would like to use AT&T WorldNet, you 
should select it to be installed during the installation of the Taking Control of Your Health disc.  (If 
you did not, you can always go back and install it at a later time.)  If you have another browser 
that you prefer to use, do not install it at this time.  

If you have questions about AT&T WorldNet Services, please call:

1-800-400-1447.

AT&T WorldNet Customer Service is available 24 hours a day, seven days a week.

Taking Control of Your Health must be configured to use your browser.  This is also an option 
during the Taking Control of Your Health installation procedure.  This involves a few steps to 
select the browser you are using and to let the Taking Control of Your Health program know 
where to find it on your computer system.  (As above, you can always go back and re-configure 
your system.)



At the time of this writing the Taking Control of Your Health will work with the following Internet 
Browsers; However, HealthWatch will only operate with Netsape Navigator browser or AT&T 
WorldNet Services software including Netscape Navigator. 

AT&T WorldNet Services software including Netscape Navigator
Netscape Navigator
NETCOM Netcruiser
Quarterdeck Mosaic
Microsoft Internet Explorer
SPRY Mosaic
GNNworks
Please consult your Browsers documentation and your Internet provider for technical assistance.

HealthWatch

HealthWatch searches AT&T HealthSite for new information on any of 244 conditions and 33 
alternative practices found in Taking Control of Your Health. The HealthWatch icon-a pair of 
binoculars- appears in any area where new information exists. Clicking on the icon launches the 
Netscape browser and brings you the results of the HealthWatch search.  This search list of one 
or more items links you to additional resources throughout AT&T HealthSite. After you've read the
new information, the icon will change: a red box will enclose the binoculars.

You'll find the HealthWatch feature in two sections of this CD-ROM: Ailments and Options and the
Alternative Therapies Overview.  

HealthWatch does not update automatically. You'll need to update the HealthWatch database on 
your hard drive and the icons displayed in your CD-ROM manually. To update this information, 
simply chose the Refresh HealthWatch option in the File pull-down menu of this CD-ROM. You 
will be prompted to launch HealthWatch daily, weekly or monthly, depending on the preference 
you chose while installing the disk. 

The HealthWatch database is stored automatically on your hard drive in the same location as this 
CD-ROM.

General Operation

You can skip over introductory screens by clicking the left mouse button.

On some machines, particularly with older CD-ROM drives, the CD can take a few seconds to 
come up to speed.  If this is the case, the program won't recognize it right away and the same 
message box will come up again.  If this happens, continue to hit 'OK' several more times, as 
needed; when the CD is fully mounted the program will move on.  Windows 95:  The program can
recognize when the CD is removed during operation.  It will refuse to go on until the CD is 
returned to the drive.  When you return the CD, a similar situation may occur.  Once again, keep 
trying to click OK’ as the CD comes up to speed, and the program will move on when it is ready.

Troubleshooting Guide

In this section you will find solutions to the most common problems experienced in setting 
up and running the Taking Control of Your Health.



Autoexec.bat File

The Taking Control of Your Health does not modify your Autoexec.bat file.
Installing WorldNet will add lines to your Autoexec.bat file.

Config.sys File

In your Config.sys file you should have the following lines.

Files=60 (60 is the minimum number you should have)
Buffers=10 (10 is the minimum number you should have)
Stacks=9,256

Installing WorldNet will add lines to your Config.sys file.

Virtual Memory

For Windows 3.1:
Taking Control of Your Health requires that Virtual Memory or a Swap File is set up on your hard 
drive.

To set up a swap file open the Control Panel (usually in the "Main" program group of Program
Manager), and select the icon "386 Enhanced."  Then selecting the "virtual memory" button will
bring up current settings of your swap file.  It is best to have a permanent swap file, but if you are
running any type of compression program such as Double-space or Stacker you must have a
temporary swap file.  To change the settings, click on the change button.  Under new settings,
check the hard drive setting, the type setting and the new size setting.  Windows will give you a
recommended size in the 'New Size' edit box.  This is the size that you should use.  NOTE:
Windows may not be able to accurately determine a recommend size if your hard drive is
fragmented.  You may need to run a hard drive de-fragmentation utility.  If you need further
information look at the Help menu of the Windows Control Panel.

For Windows 95:
We recommend that you allow Windows 95 to adjust the Swap File.  To set the virtual memory,
open up the Control Panel (usually under the "Setting" menu on the "Start" menu button).  Select 
the "System" icon.  Then selecting the "Performance" tab will bring up your current settings. 
Selecting the "virtual memory" button will let you change the settings.  "Let Windows manage my 
virtual memory settings" is the first option.  Select this and hit the "OK" button.

Temporary Directory

The Taking Control of Your Health disc also requires that a temporary directory be set and it 
should have at least five megabytes of free space available to write temporary files.  You can 
check to see if you have a temporary directory set up by typing set at the DOS prompt.  Within 
the information that comes up you should see a line similar to the following:Temp=C:\TEMP. If 
that line does not exist,  temporary files are stored in whatever directory is current.  Go to that 
location using either DOS commands or the File Manager in Windows.  If you find any files with 
the extension of .tmp or .~mp these may be deleted from your system.  They are only temporary 
files that should have been deleted by the program that created them.  They take up space and 
cause you system to run slower.  If your hard disc is nearly full, with less than five megabytes of 
space available, your temporary directory may not have enough space left for writing temporary 
files.  At this point you would need to remove some unused files or programs from your hard drive



in order to free up hard drive space for the temporary directory.

Color & Screen Resolution

Taking Control of Your Health will run in different resolutions, but looks best in 16 million color 
mode.  If you are unsure of the mode your video card is set to, consult the instruction manual for 
your video card or computer system.

No Sound

Taking Control of Your Health uses .WAV files for sound.  If you do not have a sound card, you 
will not be able to hear sound.  Make sure the master volume and the volume for .WAV files is 
turned up in your software mixer settings for your sound card.   

UnInstall

The UnInstall icon is used to remove Taking Control of Your Health from your computer.  It will 
remove all executables,  icons, .INI files and Registry entries associated with the Taking Control 
of Your Health program.  It will NOT remove anything installed by the AT&T WorldNet installation 
program or QuickTime for Windows installation program.  Also, it is not capable of undoing any 
changes made while configuring Taking Control of Your Health for your Internet browser.


